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1.1 The DSRTTY-Win Manual 

Chapter 1 

INTRODUCTION 

DSR1TY -Win is a Windows serial port terminal application designed to control hardware for the use of com­
municating data. Usually this hardware is in the form of a modem. However, this software can be adapted to 
many situations where a terminal application designed for use with a serial port is required. 

DSR1TY-Win is designed for use with Windows 95, 98, ME, and NT (service pack 4.0 and above) Operating 
Systems. The software is designed to work with newer releases of Windows as they become available. 
However, if installation fails or if the application is not performing correctly, please contact customer service 
(See Section 1.4). 

This software is capable of transmitting and receiving two different character sets- Baudot and ASCII RTTY. 
Baudot is a five bit character set widely used in HF radio communications and is a specialized mode with a 
limited character set. All printable(1) ASCII characters are supported by DSRTTY -Win with two choices for 
the data set (7 and 8 bit) as well as all possible parity choices. Data rates are easily changed to quickly and 
accurately decode data. 

1.2 DSRTTY-Win Software 

The installation software for DSRTTY-Win includes a single 3.5 inch floppy disk. All of the files necessary to 
install this software are on this floppy disk. 

1.3 Minimum Requirements 

DSR1TY -Win is designed to require the m1n1mum necessary requirements to run under the Windows 
Operating System. Typically, the minimum requirements are the same as the minimum requirements for the 
Windows Operating System. However, there are several issues that may affect performance, including other 
applications running at the same time as DSRTTY-Win. 

Minimum Recommendations 
Processor: 233MHz or above 
RAM: 32MB or more 
Floppy Drive: 1 - 3.5 inch disk drive 
Hard Drive: 5MB available space* 
Video: SVGA monitor and adapter 

*Note: Windows itself requires free hard disk space to run effectively. Take this into account when determin­
ing the space needed for DSR1TY -Win installation. 

HAL092801 DSRTTY -Win Manual 



1-2 CHAPTER 1 

1.4 Software and Documentation Update 

New versions of DSRTIY -V\Iin and its documentation will be available for purchase from HAL Communications 
Corp. as released. DSRTIY-V\Iin version and feature information is available from our website at www.hal­
comm.com. Please, contact HAL Customer Service with any questions regarding DSRTIY -V\Iin Updates. 

HAL Customer Service 
PO Box 365 
1201 W Kenyon Road 
Urbana, Illinois 61803-0365 

Phone: 
FAX: 
E-Mail: 
Internet: 

(217) 367-7373 (BAM- 5PM CST/COT; Monday- Friday) 
(217) 367-1701 (24 hours/day) 
halcomm@halcomm.com 
www.halcomm.com 

DSRTIY -V\Iin is copyrighted software by HAL Communications Corp. Copying and/or distributing this software 
is not authorized. Violators of the copyright will be prosecuted. See Chapter 5 for further details. 

DSRTIY-V\Iin Manual HAL092801 
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Chapter 2 

INSTALLATION AND SETUP 

This chapter discusses installing the DSRTTY -VVin terminal application for VVindows, the serial port connec­
tions used by the terminal software, and a description for the manual conventions used. As introduced in sec­
tion 1.1, DSRTTY-VVin can be applied to several differrent settings for a serial port terminal application. The 
main use of this application will be the control of an external data modem for use with HF radio, preferably the 
HAL ST-8000A HF Modem. If this software is used for a different purpose, contact HAL Customer Service (see 
section 1.4) for support. 

2.1 Unpacking and Inspection 

The DSRTTY -Wn terminal software package for VVindows includes the following materials. 

1 - 870-03201 
1 - 865-03201 

DSRTrY-VVin Manual 
DSRTrY-Wn Installation Disk 

V\then opening the DSRTTY -Wm shipping carton, carefully inspect it for any evidence of shipping damage. Any 
damage should be immediately reported to your shipping carrier. Be sure to save any damaged packing mate­
rials. Note that a damage claim must be filed by you with the shipping carrier- NOT HAL Communications. 
HAL will be glad to assist in such cases, but only the shipping carrier can pay claims. 

Check to be sure that all of the materials listed above are contained in your DSRTTY -Win package. If you find 
any materials missing, please HAL Customer Service (see section 1.4) as soon as possible. 

2.2 Software Installation 

Installing DSRTTY-Wn closely follows standard VVindows installation procedures. Installing DSRTIY-VVin is 
started by first obtaining the installation disk. Use the following steps to begin the installation procedure: 

1. Turn on your PC. 

2. Place DSRTTY-Win Disk into floppy drive A:. 

3. Click the Start button on the Task bar and choose Run. 

4. In the Run Dialog Box Type: A:SETUP 

5. ClickQK 

6. The DSRTTY -Wn Setup program will now begin. 

HAL092801 DSRTTY -VVin Manual 
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2.2.1 The DSRTTY -Win Welcome Screen 

The ~lcome Screen is a friendly reminder that we 
are about to begin installing software on your com­
puter. Read the warnings carefully and make sure you 
have closed all other applications currently running. 

Begin installation by clicking OK 

2.2.2 Software License Agreement 

The Software License Agreement briefly states the 
rights of HAL Communications Corp. as the develop­
er of this software. For more information on these 
rights, refer to Chapter 5, Agreements. Continue 
installation by clicking Yes. 

2.2.3 Choose Destination Directory 

For standard installation, you do not have to change 
the installation directory. If you wish to install to a dif­
ferent drive or directory click .6.rowse. You will be 
prompted to type a new directory and/or drive loca­
tion. \/\t11en finished, click OK. 

DSRTTY -V\Iin Manual 
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Figure 2.1 

Figure 2.2 

Figure 2.3 
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2.2.4 Select Program Folder 

DSRTfY -Win now asks you to specify the 
location of the program icons. Click Next to 
select the default location or type in your 
own custom name and then click Next. 

2.2.5 Start Copying Files 

DSRTfY -Win Setup will now ask for you to 
review your previous choices before 
installing files. Choose .6.ack to make any 
changes and Next to continue. 

2.2.6 Progress Meter 

DSRTfY -Win Setup will now display a 
progress meter during the installtion as it 
installs and registers the application. 

At this point DSRTTY-Win is being installed 
on the system. To remove this application 
from the Windows operating system you 
must use the Windows Add/Remove utility. 
Please consult your Wndows manual or 
help system for further information. 

2.2.7 Setup Complete 

The DSRTrY -Win Setup is complete. 

To view the readme file or automatically 
launch the application check the appropriate 
check boxes. 

To finish DSRTrY-Win Setup click Finish. 

HAL092801 
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Figure 2.4 

Figure 2.5 

Figure 2.6 

Figure 2.7 
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2.3 RS-232 Connections 

All data connections to DSRlTY are made via a 9-pin or 25-pin RS-232 serial 110 connector. These 
connections follow industry standards. Please refer to Table 2.1 for serial (RS-232) cable requirements 
to interface the PC's serial 110 port and external device. Figure 2.8 shows the typical hardware con­
nections used with DSRTTY-Win. Please, contact HAL Customer Support (see section 1.4) if you 
need assistance with the data connections to your modem. 

9PIN 25PIN 

1 8 
2 3 
3 2 
4 20 
5 7 
6 6 
7 4 
8 5 
9 22 

LABEL 

DCD 
RXD 
TXD 
DTR 
GND 
DSR 
RTS 
CTS 
Rl 

SIGNAL 

Data Carrier Detect 
Receive Data 
Transmit Data 
Data Terminal Ready 
Ground 
Data Set Ready 
Request to Send 
Clear to Send 
Ring Indicator 

DSRTTY-VVIN OPERATION 

Ignored 
Demodulated Receive Data 
Data to be Transmitted 
Set High = PC is Ready 
Ground 
Ignored 
PIT Control HIGH= TX, LOW= RX 
TXD Flow Control (Active or Ignored) 
Ignored 

Table 2.1: PC RS-232 Data 110 Connections 

~6~0, {;,6«!)0 

Rear View of 
PC 

9Pin Male 089 

Labeled As COMx DATA Modem (x = 1 ... n) 

Personal Computer (PC) A • 
Note: PCs may have • 
25 pin (0825) Serial • • connectors. If a 

Serial 9 Pin 
9 pin male/ 25 pin Female 089 
female adapter is 

<:0~6~ used, verify all data 096(;, 

lines are connected. 
Some adapters only 
connect the TXD, 
RXD, GND lines. 
25 Pin female/9 pin Custom Radio Data Cable 
male serial cables (consult your modem documentation) 
may also be used. 

Figure 2.8: Typical Hardware Connections 
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2.4 Manual Conventions 

2.4.1 Keystrokes 

The following manual conventions describe the method of certain keystrokes. 

1. All user-entered keystrokes or mouse clicks are in BOLD print. 

2. Multi-letter keytop labels are shown in [BRACKETS]. 

For example: 

[ENTER], [F1], [F8], [Ctrl], [Ait], [Shift], [Home], [PgUp], etc. Each [BRACKETED] set rep­
resents one key to be pressed. 

3. Some keys must be held down while pressing a second key. These will be shown with a 
dash(-) between key presses. The combination of these keypresses is also known as a hot 
key. 

For example: [Ait]-C should be interpreted as: 

press and hold the [Ait] key 
press and release the C key 
release the [Ait] key 

2.4.2 Special Manual Terms 

The following are special key terms used through out this manual. 

RTTY is used to generically describe data transmission with either the Baudot or ASCII character sets. 
These are sometimes specifically refered to as Baudot RTTY and ASCII RTTY seperately. 

HotKey is used to define a series of keypresses to perform a certain action. A HotKey is most often 
used to enter text into the transmit buffer such as the time, date, callsign, etc. 

Macro is used to define a special key sequence beginning with the % key. Macros are similar in func­
tion to a HotKey except they can be stored in a file as well as be entered into the transmit buffer. 

Here-IS Messages are used to describe a series of stored messages that can be sent quickly from 
disk file with special HotKeys. 

ASR I CONT is used to describe two methods for transmitting data - Auto Send and Receive or 
CONTinuous. ASR and CONT are used throughout this manual. 

SYNC is used to describe when idle characters are sent to the other station. It helps the receiving sta­
tion to mantain contact (sync) with the sending station. 

USOS is used to describe a manual shifting of the character set in Baudot and is later described. 

Other terms are defined in specific sections of this manual. Please contact HAL Customer Service 
(Section 1.4) if you have any questions regarding the use of any specific terms used in this manual. 

HAL092801 DSRTTY -Win Manual 
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Chapter 3 

USER INTERFACE 

This Chapter describes each area of the DSRlTY -Wn user interface. The user interface describes all of the 
visual aspects of the software including the menu, buffers, tool bars, etc. and the various options for each item. 
Items not discussed here will be covered in Chapter 4, Operation. If you are very familiar with the use of RlTY 
terminals then you might choose to skim this chapter and get started immediately. 

3.1 DSRTTY-Win User Interface 

Menu Bar 
(Section 3.2) 

Receive Buffer 
(Section 3.4) 

HAL092801 

Clear RX 
(Section 3.2.4) 

Status Bar 
(Section 3.7) 

Clear TX 
(Section 3.2.5) 

Transmit Buffer 
(Section 3.6) 

Splitter Bar Tool Bar 
(Section 3.5) (Section3.3) 

Figure 3.1: User Interface 

Here-IS Bar 
(Section 3.8) 
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3.2 Menu Bar 

The Menu Bar displays the features that are available in DSRTTY -Win. The typical convention used 
in \1\/indows menu bars is to underline the special HotKey that is used to display the submenu of items 
on the menu. The Menu Bar has seven main menu choices each with submenus. 

3.2.1 File 

The File menu item contains file options for saving and reading files, printing the receive data, as well 
as closing down the application. 

Save Receive prompts the user for file and directory information using the standard windows Save 
Dialog Box. The entire contents of the receive buffer are then saved to the file specified. 

Save Continuous also prompts the user for a file name. DSRTTY -Win will save new receive data to 
this file until this option is stopped (or turned off). 

Load Transmit prompts the user for a file name and adds the contents of the file to the transmit buffer. 

Send Text File sends characters directly from a disk file. A special dialog box is displayed to show the 
progress of the file transfer. Choosing Cancel will terminate this file transfer. 

Print Receive opens a printer dialog to select a windows printer and send the contents of the receive 
buffer to the printer. 

Exit displays an exit dialog to save the current settings for the application. Click Yes or No. Clicking 
Cancel will disregard the request to terminate the application. 

Note: It may seem odd to exit DSRTTY-\1\/in by accessing the File menu. However, this follows stan­
dard \1\/indows convention. 

3.2.2 Edit 

The Edit menu item contains commands used when editing text. 

Cut (Ctri+X) deletes the selected text and stores it in the \1\/indows clipboard. 

Copy (Ctri+C) stores the currently selected text in the Windows clipboard. 

Paste (Ctri+V) inserts the contents of the \1\/indows clipboard at the cursor. 

Delete (Ctri+Del) deletes the currently selected text. 

3.2.3 Options 

The Options menu displays the current state of several options available when using DSRTTY -Win. 
A common feature of \1\/indows is to allow the user to change options within an application several dif­
ferent ways. You will find that when we discuss the Tool Bar in section 3.3 all of these items will be 
repeated. To minimize repeating the same information, better descriptions will be listed here with ref­
erence to this section placed in the Tool Bar section. 

DSRTTY -\1\/in Manual HAL092801 
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Code (ALT-F1) displays submenu items ASCII and Baudot to select the current character set used. 
The current code used will be displayed with a check mark as the indicator. 

Note: Changing the code also changes the serial port configuration. 

Rate (ALT-F2) displays a submenu of the serial port data rate options with the current rate checked. 

TX Mode (ALT-F7) displays a submenu of the transmit buffer options for sending characters from the 
transmit buffer. These options are Character, V'vbrd, and Line. Character mode will send a character 
as it is typed. V'vbrd mode will send a word at a time when the next word is typed, or upon an [Enter] 
keypress. Line mode sends the contents of an entire line at a time, when the next line is begun. 

USOS (ALT-F3) changes the shift state of the receive buffer to LTRS after receiving a space charac­
ter during a Baudot RTTY transmission. When USOS is enabled the USOS menu item is checked. 

SYNC (ALT-F8) allows for the transmit of idle characters when transmit data is not pending and when 
the transmit buffer is enabled. When SYNC is enabled the menu item is checked. 

ASR (ALT-F9) changes one of the transmit states of the tra[lsmit buffer. When ASR is enabled the 
transmit buffer will toggle the PTI line independently of the state of TX En (Transmit Enable). PTT is 
set to TX only when data is pending to be sent from the serial port. And, PTT is set to RX when data 
is no longer pending for the serial port. If ASR is enabled, the menu item is checked. If ASR is not 
enabled, the state is refered to as continuous (CONT). In CONT, the PTT state is the state of Transmit 
Enable (ON = TX). ASR is further discussed in section 4.2.2. 

TX EN (ALT-F10) enables or disables the transmit buffer. When the transmit buffer is enabled, the final 
state of the transmit buffer is actually dependent upon the state of ASR, SYNC and whether data is 
pending to be sent. When the transmit buffer is enabled, this menu item is checked. 

3.2.4 Configure 

The Configure menu item is designed to provide easy access to several of the configurable options 
in DSRTTY -Win. These configuration changes can be saved when exiting the application. Most of 
these selections will display a secondary window for configuration choices. To return to the main 
screen of DSRTTY -Win, just close these secondary windows. 

Fonts will display a configuration screen (see Figure 3.2). You may choose to edit most of the font 
types, colors, and sizes as well as choose colors for the colors of the transmit and receive buffers. 

MyCall will display a simple dialog box (see Figure 3.3) to enter a callsign for 'this' station. MyCall can 
be changed at any time. 

Note: Macros have not been discussed yet, but MY CALL is an excellent example of when macros are 
useful. %M defines the mycall maco. When sending a file that uses the %M macro, mycall will always 
be transmitted correctly no matter how many times mycall is changed. Macros are listed in Table 4.4, 
Section 4.1.4. 

ASCII displays the ASCII RTTY options (Figure 3.4). These options allow for the Bit and Parity to be 
changed in the PC serial port hardware. 

Baudot displays the two character set options: U.S. Baudot and ITA #2. 

Port allows the ability to change the PC serial port hardware device that we are currently controlling. 
A list of currently supported ports is displayed. 

HAL092801 DSRTTY -Win Manual 
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CTS displays a submenu with the options of either Ignoring the CTS (Clear To Send) serial port sta­
tus line or Actively watching the line for changes. Active will adjust the state of the transmit buffer 
depending on the status of the line. 

Echo displays the current state of the receive buffer echo as sent option. \Nllen Echo is enabled text 
will be displayed in the receive buffer as it is sent from the port and the menu item is checked. 

Note: Some hardware devices create a hardware echo on the receive data line of the serial port. This 
echo data is not differentiated in the receive buffer by DSRTTY-Win. If you wish to view echo 
data as a seperate font color from the receive data, turn the hardware echo off and the Echo 
menu item on. 

Tr.::;:..;:t 

Transmit Text 

gh t. T~:::~~ t. 

Figure 3.2: Font Configuration 

Figure 3.3: MYCALL Dialog Box Figure 3.4: ASCII Options 

3.2.5 View 

View shows or hides some of the commonly used tools in DSRTTY-Win. This allows for a customiz­
able view. For example, in some cases the user may wish to maximize the viewing area of the receive 
buffer. In this case, hiding the toolbar will provide several additional lines of receive space. 

DSRTTY-Win Manual HAL092801 
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Note: Hiding the status bar is an option. However, the status bar provides useful information on the 
current status of the application. 

Tool Bar hides or shows the applications toolbar. (Section 3.3) 

Status Bar hides or shows the status bar. (Section 3. 7) 

Here-IS Bar (ALT-X) hides or shows the Here-Is Bar. (Section 3.8) 

More descriptions of all of these available tools are found in the section numbers listed above. 

Note: The Here-IS Bar option is used more frequently than the other options. The HotKey AL T-X will 
change the state of the Here-IS Bar from hidden to visible quickly. 

3.2.6 Clear RX (Ait-U) 

Clear RX (Ait-U) provides a quick method for clearing the contents of the Receive Buffer. 

3.2.7 Clear TX 

Clear TX (A lt-V) provides a quick method for clearing the contents of the Transmit Buffer. 

3.2.8 Help 

HotKeys displays a help menu of all of the HotKeys used in DSRTTY-Win. There is an option to print 
all of the HotKeys used in the application. 

Features displays a list of all of the current features in DSRTTY -Win. This list will be updated as new 
features are added to the application. 

About displays a dialog box containing important DSRTTY-Wn version information as well as a link 
to our web site (www.halcomm.com). 

Note: It is very important to obtain the version information from this page when reporting software 
issues to customer service. 

3.3 Tool Bar 

The Tool Bar replicates all of the options found under the Options Menu item (Section 3.2.3). Further 
description of the visual aspects of the tool bar are provided below. 

TX EN I TX DIS will display the state of the transmit buffer. This control can be considered to be the 
master control of the Transmit Buffer. Regardless of the many states the transmit buffer can be in, 
clicking this item controls the final state of the Transmit Buffer. 

ASR I CONT displays the Auto Send and Receive or Continuous state of the transmit buffer. 
Changing the mode the transmit buffer is made by simply clicking the buffer. Auto Send and Receive 
is further described in Section 4.2.2. 
CHAR I WORD I LINE changes the state of the TX Mode. 

CODE changes the character set used. 

RATE provides for a fast means of selecting a new data rate. The rate may be increased by clicking 
RATE or by clicking the up-arrow. The rate can be decreased by clicking the down arrow. 

HAL092801 DSRTTY -Win Manual 
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USOS controls the UnShift On Space option available in DSRTTY -V\An. USOS displays ON when 
enabled and OFF when disabled. 

Note: The USOS option is only a Baudot RTTY option and has no affect on the state of the receive 
buffer in ASCII Baudot. 

SYNC controls the state of the sync option. SYNC displays ON when enabled and OFF when dis­
abled. 

3.4 Receive Buffer 

The Receive Buffer displays data from the serial port. The receive buffer has two states for normal 
operation: Locked and Unlocked. The Locked state is used for uninterrupted editing of the data, 
while Unlocked is the normal receive state. 

Locked describes the state of the Receive Buffer to edit the contents including copy, cut, paste, and 
enter hiscall (also right click options). The Locked state should be considered a temporary state and 
the user should not allow the locked state to persist longer than necessary. However, DSRTTY -V\An 
will hold receive data for the Receive Buffer until the receive buffer is no longer locked. The Receive 
Buffer will have a red border when locked to alert the user to Unlock the buffer when finished editing. 
Locking and Unlocking the control is designed to be intuitive for the user. Clicking and scrolling the 
buffer locks the Receive Buffer, while moving the mouse outside of the Receive Buffer Unlocks the 
control. 

Unlocked describes the state of the buffer during normal operating. The buffer will display text using 
the options of the Fonts dialog (see section 3.2.4). Again, as described above, to Unlock the Receive 
Buffer simply move the mouse outside of the Receive Buffer. 

The Receive Buffer also includes a double left click feature to enable quick capture of the sending sta­
tions Call Sign or ID into a special buffer. This is often refered to as HISCALL and is described in 
Section 3.5. 

3.5 Splitter Bar 

The Splitter Bar adjusts the Receive Buffer and Transmit Buffer height as well as provides useful! 
buffers and options for HISCALL. 

To adjust the height ratio of the Receive Buffer to the Transmit Buffer simply click and drag the Splitter 
Bar up and down. The Receive and Transmit Buffers will be resized automatically. 

Note: V\!11en adjusting the DSRTTY -V\An Receive and Transmit Bufers the application will retain a cer­
tain minimum size for each buffer. 

HISCALL contains a HISCALL buffer for use with HotKey and macros in DSRTTY-V\An. 

HIS DE MY loads the contents of HISCALL buffer "DE" and MYCALL (the station's call sign) into the 
Transmit Buffer. 

DE MY loads "DE" and the station's call sign into the transmit buffer. 
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3.6 Transmit Buffer 

The Transmit Buffer is a storage area for data to be sent from DSRTTY -V\Iin to the PC serial port. 
When data is sent from the Transmit Buffer is dependant on several options within DSRTTY-Win. 

The Transmit Buffer displays text in two different colors to easily view the status of the data that has 
been sent to the serial port hardware. 

Note: The Transmit Buffer can easily be edited with mouse controls when the Transmit Buffer is dis­
abled (TX DIS). However, this is not the case when the buffer is enabled (TX EN). In this state, 
the easiest method to change text in the Transmit Buffer is to use the keyboard options. 

3. 7 Status Bar 

The Status Bar is very helpful in determining the state of the Transmit Buffer, the current character shift 
in Baudot RTTY, and the time in UTC format. 

3.8 Here-IS Bar 

The Here-IS Bar is a friendly tool that alows for easy editing of special Here-IS messages. The Here­
IS Messages are a set of files that are commonly used by the user. The messages are easily config­
ured by manually editing the 10 Here-IS files found in the program directory. An even easier method 
is to right click the Here-IS Bar Here-IS Message that you wish to edit. Right clicking the Here-IS Bar 
allows you to rename the text that is displayed for that particular Here-IS Message. 
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Chapter 4 

Operation 

This Chapter covers the general operation features of DSRTTY -Win. Many of the features of DSRTIY -Win 
and the visual aspects of the software were described in Chapter 3, User Interface. Here we will describe how 
to use the features of the application not already covered, including: Serial Port Data Rates, Keyboard Control, 
and Transmit Buffer Control. 

4.1 Serial Port Data Rates 

DSRTTY -Win uses the PC serial port to send and receive RTTY data transmissions using either Baudot or 
ASCII data codes at data rates between 45 and 9600 baud. Available DSRTTY-Win data rates are: 

45, 50, 57, 75, 100, 110, 150, 300, 600, 1200, 4800, 9600 Baud 

4.2 Keyboard Control 

Keyboard Control of the transmit buffer is covered in several tables including Function Keys, [AL T]-Character 
Keys, [CTRL]-Character Keys, Special Keys, and Macros. 

Note: Macros and HotKeys are subject to change. Please refer to the Help page for updated information. 

The use of the term HotKeys is generally reserved for the use of holding the [All] key while actively press­
ing and releasing a secondary key. Our use of the term HotKey will cover any of the special key presses cov­
ered in this section. 

4.2.1 Functions Keys 

The Functions Keys are [F1]-[F10]. V'lnlen these keys are pressed the contents of the Here-IS Messages are 
displayed in the transmit buffer. This allows for the user to send commonly used files very quickly. The mes­
sages are edited from the Here-IS Tool Bar covered in section (3.8). There are ten editable Here-IS Messages. 

Note: The [F1] key is reserved for transmitting a Here-IS Message. The normal convention is to display the 
help screen upon pressing this key. To display the help screen instead use the [ALT]-H HotKey described 
below. 

4.2.2 [ALT]-Character Keys 

The [ALT]-Character Keys are used with the manual conventions described in Section 2.4. Please, refer to 
Section 2.4 for this manual convention used in describing how to press and release the HotKeys listed. 

The [AL T]-Character Keys are listed in Table 4.1. 
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HotKey Function 

Adds Both Time and Date to the Transmit Buffer [AL T]-B 
[ALT]-C 
[ALT]-D 
[ALT]-F 
[AL T]-H 
[ALT]-1 
[ALT]-L 
[ALT]-M 
[ALT]-P 
[ALT]-Q 
[ALT]-R 
[ALT]-S 
[ALT]-T 
[ALT]-U 
[ALT]-V 
[ALT]-W 
[ALT]-X 
[ALT]-Y 
[ALT]-Z 

Adds the contents of the "HISCALL" buffer to the Transmit Buffer 
Displays the Date in the Transmit Buffer 
Forces RX Shift to FIGS immediately (Also see Alt-L) 
Displays Hot Key Help Screen 
Adds "DE" and MYCALL to the Transmit Buffer 
Forces RX Shift to LTRS immediately (Also see Alt-F) 
Adds MYCALL to the Transmit Buffer 
Toggles Display LTRS/FIGS case (Baudot Only) 
Adds QBF Test Message to the Transmit Buffer 
Adds Ruler Line Test Message to the Transmit Buffer 
Adds U.S. Military Test Message to the Transmit Buffer 
Adds Time to the Transmit Buffer 
Clears the Receive Buffer 
Clears the Transmit Buffer 
Adds 12 LTRS Characters to the Transmit Buffer 
Hides I Shows the Here-IS Toolbar 
Adds 36 RYs to the Transmit Buffer 
Adds U.S. Military Date-Time Group to the Transmit Buffer 

Table 4.1: [ALT]-C Hot Keys 

4.2.3 [CTRL]-Character Keys 

The [CTRL]-Character Keys are listed in Table 4.2 below. 

HotKey 

[CTRL]-F 
[CTRL]-M 

4.2.4 Special Keys 

Function 

Displays the Configure Fonts/Colors Dialog 
Displays the MYCALL Dialog 

Table 4.2: [CTRL]-C Hot Keys 

The Special Keys are listed in Table 4.3 below. 

HotKey 

Esc 

< 
> 
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Function 

Immediately disables Transmit in Main Application and 
Closes Secondary Dialog Windows (ie. Fonts Dialog) 

LTRS Character (Baudot Only) 
FIGS Character (Baudot Only) 

Special Keys 
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4.2.5 Macro Hot Keys 

Macros are more advanced HotKeys because they can be stored in file format. This is especially help­
ful when creating new text files for the Here-IS Messages. For example, the Macro %Twill display the 
current time in UTC format regardless of when sent from the Transmit Buffer. 

Note: The use of the % key with a space or invalid character will just process a % in the Transmit 
Buffer. This is especially helpful in ASCII RTrY where the '%' key is sometimes used prior to a 
space character. To force the transmission of the '%' key use the %% macro. 

The Macro Keys are listed in Table 4.4 below. 

HotKey 

%C 
%D 
%1 
%M 
%Q 
%R 
%S 
%T 
%W 
%Y 
%Z 
%% 

Function 

Adds the contents of the "HISCALL" buffer to the Transmit Buffer 
Displays the Date in the Transmit Buffer 
Adds "DE" and MYCALL to the Transmit Buffer 
Adds MYCALL to the Transmit Buffer 
Adds QBF Test Message to the Transmit Buffer 
Adds Ruler Line Test Message to the Transmit Buffer 
Adds U.S. Military Test Message to the Transmit Buffer 
Adds Time to the Transmit Buffer 
Adds 12 LTRS Characters to the Transmit Buffer 
Adds 36 RYs the the Transmit Buffer 
Adds U.S. Military Date-Time Group to the Transmit Buffer 
Adds a '%' Character to the Transmit Buffer. 

Table 4.4: Macro Keys 

4.3 Transmit Buffer Control 

4.3.1 Transmitting Text 

The Transmit Buffer allows for the user to pre-type text in the Transmit Buffer similar to that of a stan­
dard word processor. The Transmit Buffer will word wrap so that no words are split at the end of a line. 
As a line of text is sent from the buffer, the line will be removed. 

4.3.2 ASR (Auto Send and Receive) 

In ASR mode, DSRTTY -\/\An will initiate PTT when text is pending in the buffer to be sent. To disable 
PTT, press the [ENTER] Key at the end of the transmitted data. ALWAYS, end a transmission with 
[ENTER] as the last key typed. 

In CONT mode, the transmit buffer is totally manually controlled and MUST be enabled and disabled 
by one of the User Interface (Chapter 3) options. 

Note: The use of the space key is sometimes used to begin an idle transmission with SYNC idles 
(when SYNC is enabled). The space will activate the PTT line and DSRTrY-\Nin will fill the data 
stream with idle characters until pending data is available. 
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4.3.3 CHAR I WORD I LINE Mode 

To determine when pending data for the serial port is sent there are three options available: Character, 
\1\.brd, and Line. 

In Character (CHAR) mode, characters are sent from the Transmit Buffer as they are typed, or until 
previous characters typed are sent. 

In \1\.brd (WORD) mode, characters are sent in word groups from the Transmit Buffer as new words 
are typed. 

Note: \1\.brd mode is sometimes confusing to beginning RTTY operators, however it is often the pre­
ferred method for sending RTrY. Remember after you begin a new word in the buffer, the last 
word typed will be sent (if the transmit data has caught up). Typing a word and then a space will 
still allow correction of the word typed prior to the word being sent to the PC serial port. 

In Line (LINE) mode, characters are sent in groups of lines from the buffer. 

Regardless of the current mode, if using ASR mode remember to ALWAYS end the transmission with 
the [ENTER] Key being the last pressed key. This allows DS-RTTY -Win to stop the transmission when 
there is no pending data. 
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Chapter 5 

Agreements 

This Chapter describes the policies used by HAL Communications Corp., including the distribution of of Future 
Software Revisions, License and Copyright, and Limited \Mmanty. If you have any questions regarding this 
software or license agreement, please contact HAL Customer Service. 

HAL Customer Service 
P.O. Box 365 
Urbana, IL 61803-0365 

5.1 Future Software Revisions 

Phone: (217) 367-7373 
FAX: (217) 367-1701 
E-Mail: halcomm@halcomm.com 

As errors or inconsistencies in DSRTTY-Win are discovered, DSRTrY-Wn may be modified at the discretion 
of HAL Communications Corp. Software revisions of the purchased version will be available to all DSRlTY­
Win owners of record under the following conditions: 

1. HAL cannot notify each DSRTTY-Win user a new software version is released. If you do notice a problem, 
contact HAL Customer Service. We may have already solved the problem. HAL reserves the right to interpret 
what is a software "bug" and what constitutes normal operation. 

2. If you dersire a copy of the latest software version, mail your ORIGINAL HAL diskette back to HAL request­
ing the new revision. Be sure to pack it properly to avoid damage. You pay the postage and handling to HAL. 

3. V'litlen your diskette is received, HAL will copy the new software and mail the diskette back to you. HAL will 
pay the postage to addresses within the 48 contiguous United States. 

4. If the diskette is damaged when received by HAL, we will supply a new diskette containing the software. 

5. This policy applies only to corrections of problems discovered with features described in this DSRlTY -Wn 
manual and such agenda as HAL may issue. This policy in no way obligates HAL or its representatives to pro­
vide revisions or custom features. 

6. DSRTrY-Wn owners outside the 48 contiguous United States may also receive software updates for a fee 
of $7.00 in U.S. funds (no checks, please). 

7. DSRTrY -Win is written for Wndows 32 bit operating systems, 95, 98, ME, NT 4.0, and a PC hardware seri­
al RS232 port. This software may work with newer Windows Operating systems as they are released. 
However, HAL assumes no responsibility for proper operation of DSRTrY -Win software. 

8. Documentation of software revisions will be included with each software revision. This file is known as a 
README file and is located in the applications program directory. 
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5.2 License and Copyright 

By installing this software you are agreeing to these terms. 

This software is owned by HAL Communications Corporation and is protected by United States copy­
right laws. Therefore, you must treat the software like any other copyrighted material. One copy of this 
Software may be made for backup or archival purposes only. 

All programs and accompanying materials are provided AS IS without any warranty of any kind. The 
complete risk as to the quality and performance is with you. HAL makes no warranty or representa­
tion the functions contained in the Software will meet your requirements, or that the operation of the 
Software will be uninterrupted or error free, or that any Software defects are correctable or will be cor­
rected. 

This manual and all future addenda to it are copyrighted by HAL Communications Corp. This docu­
ment may not be copied or reproduced in any manner in whole or in part without the express advanced 
permission of HAL Communications Corp. 

5.3 Limited Warranty 

This software and documention are sold "AS IS" without warranty as to their performance, merchabil­
ity, or fitness for any particular purpose. The entire risk as to the quality and performance of the soft­
ware is assumed by the user. 

HAL Communications Corp. warrants to the original purchaser ONLY that the diskette on which 
DS-RlTY -Win is furnished is recorded free from defects in materials and workmanship for a period of 
ninety (90) days from the date of purchase. If during this period a defect in the diskette should occur, 
return the defective diskette to HAL Communications Corp. and we will replace the diskette free of 
charge. This is your sole and exclusive remedy in the event of a defect. A dated copy of the original 
sales receipt or invoice must be submitted with the diskette as proof of original purchase. 

Correct installation, use, and maintenance are essential for proper performance of this product. The 
purchaser should carefully read the user manual. 

This warranty does not apply to any defect which HAL Communications Corp. determines is due to 
accidental or intentional damage. 

All implied warranties are limited in duration to a period ninety (90) days from the date of purchase by 
the original retail purchaser. HAL Communications Corp. disclaims any liability for incidental or con­
sequencia! damages arising out of the use of, or inability to use, this product. This warranty gives you 
specific legal rights, but there may be additional rights. 
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